
WHAT???

You want help on the ABOUT  BOX???    What are you, nuts???

Oh, all right. (Grumble, grumble...)

Urhmmm.    "The About Box is a dialog box that is displayed when the curious
User..."

Just kidding.

You see, I'm really not sure what you were hoping to find here.    This is a 
copyrighted program, at least one version of which is distributed via the 
"shareware" method.    The program was conceived, designed, implemented, 
etc, etc by Everett Kaser (that's me).    Should you have any questions, 
qualms, queries, or quixotic behavior patterns, please feel free to call or 
write.    The address and phone number are in the About Box (which you 
should    be reading instead of this HELP on the About Box!).



All About Clues
Playing Board Clues
At the beginning of most games, some locations on the playing board will have only one
large image displayed (rather than some number of half-sized images).    This is the "is 
located" clue, and it means that the game is "giving" you that location, telling you that 
the image displayed is located at that spot.    You cannot move, remove, or otherwise 
change these "given" clues.    All of the other locations (containing the small, half-sized 
images) are "unknowns".    You don't know which image is located at those locations, 
just that it's one of the small images displayed there.    Any time an image is enlarged 
(by the game "giving" you that location or by you clicking the left mouse button on one 
of the half-sized images) that image is automatically removed as a possibility from all of 
the other columns.    (We don't want you to have to do all of the work!)

Vertical Clues
The vertical clues are shown across the bottom of the game display.    There are two 
types of vertical clues, "is in same column"    (shown below on the left) and "is not in 
same column" (shown below on the right).    The only difference in the appearance of 
these two clue types is the red "NOT" symbol (a circle with a slash through it).

Several different deductions can be made from the vertical clues.    With the above 
clues, if you knew where the White House was located (it was a single large image on 
the game board), then you would also know where the Banana was located, as the clue 
on the left is telling us that the White House and the Banana are in the same column 
(and the houses are always in one row and the fruits are always in one row).    
Conversely, if you knew where the Banana was located, then you would also know 
where the White House was located.    Once you know where both of them are located, 
then this clue becomes useless, and it can be moved to the "Other Clues" area by 
pointing at it and clicking the right mouse button.

Another type of deduction that can be made from that clue is if you know where any 
other house is located (say the Blue House, for example), then you can remove the 
Banana as a possibility from that column (the column containing the Blue House).    You 
can do that because obviously the White House can not be located where the Blue 
House is, so the Banana can't be located in that column either, since it has to be in the 
same column as the White House.    Of course, the other case is eqally true: if you know
where any other fruit is located, then you can remove the White House as a possibility 
from that column.    A similar deduction is that if the White House or Banana is removed 



as a possibility from anywhere (because of another clue), then the other one can also 
be removed from that same column (because of this clue).

With the "is not in same column" clue (the Two and the letter S above with the NOT 
symbol over them), you can make fewer deductions.    In order to make any deductions 
from this clue, you must know where at least one of the images is located.    Then, you 
can remove the other image as a possibility from that column (because they can't be in 
the same column).    This is a much less useful clue than the "is in same column" clue, 
but still useful at least once in solving the puzzle.

Horizontal clues
The Horizontal Clues are shown in the upper right portion of the display, in three 
columns of seven clues each.    Each clue consists of three images side by side which 
show relative positions of images based upon their column positions.    There are four of
these horizontal clue types.    The first is the "is next to" clue:

Notice that this clue has the same image on the left and right sides and a different 
image in the middle.    This means that the One image is immediately to the left or right 
of the Blue House (column-wise), but you don't know which.    For example, if the Blue 
House were located in column 6, then the One would have to be located in column 5, as
that is the only column next to the column containing the Blue House.    But if the Blue 
House were located in columnn 5, then the One could be located in either column 4 or 
column 6 (and has to be in one of those columns.    Similarly, if the One was known to 
be located in column 3, then the Blue House would have to be located in column 2 or 
column 4.

You can also use this clue to remove possibilities.    If the Blue House cannot be in either
column 1 or column 2, then the One cannot be in column 1 (since, if it were, the Blue 
House would not then be able to be next to it).

The next clue type is the "is left of" clue:

The three dots in the center of this clue are "ellipses", and are used here to denote that 
the distance between the two outer images is unknown.    They could be next to each 
other (in adjacent columns), or they could be clear across the board from each other (in 
columns 1 and 6).    Regardless of how far apart or close together they are, this clue 
tells you that the Six is somewhere to the left of the 55-Speed sign.    (A corollary of this 
is that the Six is also not in the same column as the 55-Speed sign.)    So, as soon as 
you start a puzzle with a clue like this, you could remove the Six from column 6 (since if 
it were in the right-most column on the board, the 55-Speed sign would have no way of 
being to the right of it), and you could remove the 55-Speed sign from column 1 (since if



it were in the left-most column, the Six would have no way of being to the left of it).

The next clue type is the "is between" clue:

This clue tells us that these three images are all in adjacent columns, and that the 
middle image is between the outer two.    The arrow across the top of the clue means 
that the outer two images (the Orange and the Red house, in this example) could be the
way they're shown, or reversed.    This clue puts great limits upon the possible locations 
of these three images.    In this example, the Railroad sign cannot be in column 1 or 
column 6, since we know that it has an image on both it's left and right sides.    
Additionally, if the Orange is not possibile in the columns adjacent to (left or right of) a 
particular column, then the Railroad is not possible in that particular column.    For 
example, if the Orange is not possible in column 2 or column 4, then the Railroad sign 
cannot be located in column 3.    The reverse is also true.    Similar logic can be applied 
to the Railroad sign and the Red House.    Another aspect of this clue is that the Orange 
is two columns away from the Red House.    Therefore, if the Orange is known to be 
located in columns 1, 2, 5, or 6, then the locations of the Railroad and the Red House 
are also known, since they can only be located towards the middle of the board from the
Orange.    But if the Orange is located in column 3 or column 4, then the Railroad and 
the Red House could be to its left or right.

The last clue type is called "is not between":

This clue is very similar to the "is between" clue, except that in this case it's saying that 
the middle image is not between the outer two images (but the outer two images still 
have one column in between them).    You can make fewer deductions with this clue 
than with "is between", but it's still very useful for locating images (and removing 
possibilities).    The thing to do is to ignore the middle image until you know where both 
of the outer two images are, and then you can remove the middle image from in 
between them.    Other than that, this clue basically says that the left image is two 
columns away from the right image, either to the left or the right.    One of the subtle 
ways this is useful is (using the above images as an example) if the Apple is not 
possible in column 1 or column 5, then the Six is not possible in column 3.

"No" clues

Usually, each puzzle will have a few images for which there are no clues.    These 
images are placed by themselves at the end of the vertical clues area (all the way to the
right) or, if there's not enough room there, at the end of the horizontal clues space.    
These "no clues" clues are just a single image, and are there primarily to make it easy 
for you to know that there are no clues involving that image.



Managing Clues

The clues can be moved and regrouped (within the vertical clues area and within the 
horizontal clues area) by pointing at the clue you wish to move, holding down the left 
mouse button, and dragging the clue to its new location, then releasing the left mouse 
button.    If necessary, the
other clues will be moved about (shifted) to make room for the "moved clue."

Also, once a clue has been "used up" (all of the deductions that can ever possibly be 
made from it have been made), then the clue is just a distraction, and should be moved 
to the "Other Clues" area by pointing at the clue and clicking the right mouse button.    
Be very careful before doing this, though, to make sure that the clue will never be of 
any further use to you in solving the puzzle.    Here's an example of when a clue is "all 
used up" is this.    Suppose a horizontal clue tells you that the Stop Sign is in a column 
next to the Red House, and you know that the Red House is in column 5.    You can 
remove the Stop Sign from all columns except 4 and 6 (and let's suppose that it's still 
possible in both columns 4 and 6).    Once you've removed the Stop Sign from all 
columns except 4 and 6, this clue has been "used up" because no matter where the 
Stop Sign is located, it's next to the Red House (both columns 4 and 6 are next to 
column 5), so this clue will never tell you any more about the location of the Stop Sign 
(and you already know where the Red House is located).    So, off to the "Other Clues" 
area it goes.

Now, occassionally you will send a clue off to the Other Clues area before its time.    You
can recover these clues by clicking on the Other Clues button.    This swaps the clues 
that are currently visible with those in the Other Clues area.    (It's a toggle, if you click 
Other Clues again, they get swapped back.)    While viewing the Other Clues, you could 
"right click" on one of the clues and send it to the Other Clues area (which now contains
the "still useful" clues) and then click on Other Clues again.    You will have now 
recovered that clue which you discarded too soon.

Final Words of Wisdom:

Always remember: when learning the game, it is not a mortal sin to use the HINT 
button, which will find a deduction for you and explain why.



All About The Game
INTRODUCTION
Sherlock was based upon a puzzle that I fondly remembered from my high school days. 
In that puzzle you were told that there were five different colored houses side-by-side, in
a row.    A person of a different nationality lived in each house, and each person had a 
different pet, drank a different drink, drove a different car, etc.    Then you were given a 
list of clues to help you figure out where everything was.    I had long since lost my copy 
of that puzzle (that was around 1969, for those of you wondering just how far I am down
the garden path), so I mis-remembered the puzzle, thinking there were six houses.    
About a week after I released the original version of Sherlock for DOS (in 1991), I 
stopped by the magazine rack in the grocery store, thinking that maybe I'd find a puzzle 
magazine that might give me an idea for a new puzzle type game.    I was quite 
surprised to find that there were regularly published magazines with nothing but these 
kinds of puzzles, and they were called "logic puzzles."    (Yes, it had been a long time 
since I'd looked closely at these puzzle magazines!    So, sue me.    On second thought, 
don't...)    Anyway, I've since come across a reasonably close facsimile of that original 
puzzle, and I've included it here for those who are interested.    Just click on Who Drinks 
Water and Who Owns the Zebra.

Sherlock implements basically the same thing, but done in a graphical environment 
where you use the mouse to organize the clues, keep track of possibilities and 
impossibilities, and mark the deduced locations of objects.    The licensed version of the 
game contains over 131,000 different puzzles, enough to keep you occupied for at least
a few years.

THE REAL INFORMATION
The main game display is organized into three main areas (aside from the normal 
Windows stuff):    the playing board in the upper left, the horizontal clues in the upper 
right, and the vertical clues across the bottom.

The Playing Board consists of six rows, with each row containing six related pictures 
(six people, six numbers, six different fruits, etc).    Initially, each location in a row shows 
all six possibilities for that row as half-sized images.    The half-size image indicates that 
they are only possibilities.    When a row/column location is inhabited by a single full-
sized image, that indicates that the block is (or, at least, is believed to be) located there.



As you deduce that an item can't be in a given square, the right mouse button can be 
used to remove that possibility from that location.    When you've deduced that a specific
item has to be at a specific location, the left mouse button can be used to signify it.    
The game is "over" when you have (correctly or incorrectly) specified locations for all 36
items.    There is a checkbox in the Player Setup Dialog ("Notify on wrong deductions") 
which controls whether the game will notify you or not when you make an incorrect 
deduction.

The Horizontal Clues area is to the right of the playing board.    These clues show 
relationships between items that are in different columns.    See All About Clues for more
information about these.

The Vertical Clues area is across the bottom of the Sherlock window (beneath both the 
playing board and the horizontal clues).    The vertical clues show relationships between 
items that are in the same columns.    See All About Clues for more information about 
these.

Additionally, there is a non-displayed area called Other Clues.    As you work on a 
puzzle, you will find that some clues become useless to you (if a clue tells you that two 
items are in the same column, and you already know in which column they are both 
located, then the clue holds no more useful information for you).    At that point, it's just 
cluttering up the display and distracting you.    If you point at the clue and click the right 
mouse button, the clue will be sent to the non-displayed Other Clues area.    However, 
occassionally you might send a clue to the Other Clues are by mistake, before you've 
really used all of the information which it presents.    The Other Clues pushbutton at the 
top-left of the window swaps all of the clues that are visibly displayed with all of those 
that are in the Other Clues area, allowing you access to them once again.    The Other 
Clues pushbutton is a "toggle", alternately displaying the two groups of clues.    The 
right mouse button can be used at any time to send a clue from the currently visible set 
of clues to the set that is in the Other Clues area.    Initially, at the beginning of each 
puzzle, all of the clues are always visible, and there are no clues in the Other Clues 
area.

The whole Object of the Game is to correctly locate all 36 blocks.    This is done through 
a process of deduction and elimination, using the clues as a guide.    When a clue tells 
you that a particular image can not possibly be located at a particular square on the 
board, point to the half-sized image at that location with the mouse and then click the 
right mouse button.    The image at which you pointed will disappear.    When there's only
one small image left, it MUST be the one that is located at that square.    When that 
happens, point to it with the mouse and click the left mouse button.    The block will be 
made full-sized and all other half-sized images of that block in the row will disappear.

Also, watch for situations where a particular block exists as a possibility at only one 
location.    This means that it HAS to be located there, so it can be enlarged.

In order to solve the puzzle, you must repeatedly scan through the clues, testing each 



clue to see if it will eliminate any more possibilities in each column and row.    Each time 
you remove one possibility from the board, that may cause other clues to become useful
in removing further possibilities.    Remember, all boards are guaranteed to be solvable 
with the provided clues.    (No, I haven't played all of the puzzles myself.    I'm trusting to 
my programming abilities and the accuracy of my algorithms, a chancy thing at best, but
no one has yet found a Sherlock puzzle that's not solvable!)

When you locate the last of the 36 blocks the game is over, and the program will tell you
whether your deductions were correct or not.

When the program is run, if there are no players currently configured, you will see the 
Player Setup Dialog, with the player name set to "Set Your Name Here."    You should 
type in your "game name" at this point, although it's recommended that you retain the 
other default settings until you're familiar with the game and how it operates.    If there is 
exactly one player setup when the program is run, then the game bypasses the Player 
Setup Dialog and goes straight to the game display.    You can bring up the Player Setup
Dialog at anytime during the game by clicking on the status bar at the bottom of the 
window, or by clicking on File-Player Setup in the menu.    If there is more than one 
player setup when the program is run, then the Player Setup Dialog is displayed 
automatically in order to allow you to select the desired player name before the game 
starts.

Popup Tips: when you first run Sherlock, there should be some annoying little "popup 
windows" that show up each time you stop moving the mouse.    These little "popup tips"
are intended to help you learn how to play the game, what the clues mean, and so on.    
After you've learned these things, you can turn of the popup tips in the Player Setup 
Dialog.

See also: All About Clues, Hints and Tips. 



BMP Files and Sherlock
Sherlock for Windows stores its image sets in .BMP files.    The following is "sort of 
technical" information for those people wishing to edit the .BMP files, whether using the 
Image Editor built into Sherlock or using a stand-alone graphics editor of choice.

The Sherlock .BMP files are 256 color bitmaps, and their width is EXACTLY 3/4 of their 
height.    This is because the individual "block images" within the image set are square, 
exactly as wide as they are tall, and measured in this individual "block images", the 
entire bitmap is six wide and 8 high, thus giving us a constant ratio of 3 to 4, regardless 
of the size of the bitmap.    (Isn't math fun!?!)    If the ratio of 3 to 4 (or 6 to 8) is not 
maintained, Sherlock may not operate correctly.    With freedom comes responsibility.

There is no size restriction on the actual size of the bitmap, because Sherlock will 
stretch (or shrink) it to fit the available display space.    However, when the images are 
stretched (or shrunk), they can get kind of ugly, which is why the primary image set 
comes in four different resolutions, each one optimized for a particular display 
resolution.    When first started, Sherlock tries to pick the best one for your display, but it 
expects to find the file names SHER640.BMP, SHER800.BMP, SHER1024.BMP, and 
SHER1280.BMP, so if they're not there, it may not do such a hot job, if you know what I 
mean.

The first six rows of block images in the .BMP file are the actual game images, grouped 
quite naturally by row.    The seventh and eighth rows contain some additional images 
that are needed by the game to properly display the clues.    They are:

Row 7      Col 1 Background tile, goes behind clues and game board 
locations.
Row 7      Col 2 Unused (used to be AND mask for drawing the NOT 
symbol.)
Row 7      Col 3 OR mask for drawing the NOT symbol.
Row 7      Col 4 Unused (used to be AND mask for drawing left-pointing 
arrowhead.)
Row 7      Col 5 OR mask for drawing left-pointing arrowhead.
Row 7      Col 6 Unused (used to be AND mask for drawing middle of arrow.)
Row 8      Col 1 OR mask for drawing middle of arrow.
Row 8      Col 2 Unused (used to be AND mask for drawing right-pointing 
arrowhead.)
Row 8      Col 3 OR mask for drawing right-pointing arrowhead.
Row 8      Col 4 The "...is somewhere to the left of..." symbol (ellipses).
Row 8      Col 5 Unused.
Row 8      Col 6 Unused.

The background tile is just that: a background "place-holder" to provide a grid-like 
framework for when there are no clues in a particular area.    This image can be 
anything.



The "Unused" tiles in Row 7 Cols 2,4,6, and Row 8 Cols 2,5,6 are not used in any way 
by Sherlock.    Therefore, these two locations are nice "scratch" storage areas while 
you're developing your image set (to store alternate versions of an image, or to try 
something without risking messing up your original version).    Another thing you can do 
with these is to place your name there.    Remember, though, that you can't just modify 
someone else's images and then claim them as your own.    It's in violation of copyright 
laws, morally reprehensible, and besides all that, it's just not right!

On previous versions of Sherlock, the NOT symbol and the left/right ARROW symbol 
were drawn on top of some clues via a combination of and AND-mask and an OR-
image.    This has been simplified, and the AND-mask is no longer needed.    The OR-
image now takes care of everything, but there's one little item you might want to know:    
The background MUST remain "black" (the color in the top-left-most corner of the 
palette in the Image Editor).    Any pixel in the OR-image that is black will not affect the 
clue image "behind" the ARROW or NOT symbol, but ALL other colored pixels will over-
write the clue image.    Because of this change, all of the AND-mask images are now 
unused and are available as "scratch" storage areas, as mentioned in the preceding 
paragraph.

Although you are free to edit and change any of the images until your heart's content, 
remember that if you're planning on sharing your images with anyone else, you should 
probably maintain some semblance to the original NOT, ARROW, and ELLIPSES 
symbols, so that others can understand the meaning of the clues when using your 
image set.



Best Times Dialog
The Best Times dialog is either very boring, or very interesting, depending upon how 
much you eat, sleep, drink, and do other messy things with statistics.    (Myself, I've got 
things to do that are much more fun than statistics.    Unfortunately, I rarely find the time
to do them!)

On the left side of the Best Times dialog you will find a list of the all-around best times, 
including all players, sorted by time.    On the right side of the dialog you will find the 
best times for just the current player, again sorted by time.    Both lists show the time, 
the puzzle number, the handicap that was used when that puzzle was solved, and name
of the player.    The game tries to keep track of every puzzle that gets solved, which 
could add to quite a few puzzles for some of you.    Hopefully, the program won't self-
destruct or slow down too much after you've played your 10,000th game!

Oh.    Also, at the top of the dialog box, are some average times for both All Players and 
for the current player.    Average is just that: the average time for all puzzles that have 
been completed.    Last 100 is the average of the last 100 puzzles solved.

These times may be printed from the File-Print Times menu item.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: ALT+F4 closes the Sherlock window or dialog box
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Sherlock for Windows is Copyrighted 1991-96 Everett Kaser.    All rights reserved.
Contact information:

Everett Kaser Software
Sherlock for Windows
PO Box 403
Albany, OR    97321-0117

Phone:
(541) 928-5259
Our area code USED to be 503, but the phone company changed that in 
Nov '95.    Some parts of the country haven't updated their phone systems 
yet to know about 541, and the 503 will work to reach us until June '96.    
After that, if 541 still doesn't work in your area, call your phone company 
and give 'em heck!

email:
internet: everett@kaser.com
compuserve: 70673,1547
aol: EverettK

World Wide Web:
http://www.kaser.com/~everett



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Current Color    A window displaying a sample of the currently selected color.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Resize Resizes the current images for a new screen size.



Exit command (File menu)

Use this command to end your Sherlock session.    You can also use the Close command on 
the application Control menu.    If in the Image Editor, Sherlock prompts you to save the 
edited images with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Sorry, .BMP is the only supported file type.
Drives

Select the drive in which Sherlock stores the file that you want to open. 
Directories

Select the directory in which Sherlock stores the file that you want to open.
Network...

Choose this button to connect to a network location, assigning it a new drive letter. 



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Sherlock adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



File menu commands

The File menu offers the following commands:

Restore Game Restores a previously saved game.
Save Game Saves the current game to disk.
Player Setup... Opens the Player Setup Dialog.
Image Editor Opens the Image Editor to allow you to modify the images.
Print Puzzle... Prints a puzzle.
Print Times... Prints puzzle times list
Print Setup Selects a printer and printer connection.
Exit Exits Sherlock.



Full-sized and Half-sized images    Sample "game-sized" images of what you're 
editing.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



Hints and Tips
You want some hints, huh?    Well, let's see...

1) Always look both ways before crossing the street.
2) The first thing to do at the beginning of the game is to look for any clues containing 

an image who's location is already known (on the playing board).    Usually, you'll be 
able to make some real good deductions from these.

3) Once you've run out of things to do from number 2), look for horizontal clues of the 
"is between" type (three different images with an arrow across the top).    The middle
image can never be in column 1 or column 6.

4) Next, look for horizontal clues of the "is left of" type (with the three "dots" between 
the outer two images).    The left-most image can never be in column 6 and the right-
most image can never be in column 1.

5) Any time that you figure out where an image is definitely located (you make it bigger 
on the playing board), immediately scan all of the clues for any other clues that refer 
to that image.    This save a LOT of time.

6) When doing number 5), don't forget what you were working on before that.    
Forgetting costs a LOT of time.

7) Clean up your plate.

Here's a list of the "tips" that are displayed in some of the pop-up tip windows:
Click UNDO when you make a mistake on the solution.
Click right button to send a clue to OTHER CLUES bin.
OTHER CLUES is a good place to store useless clues.
OTHER CLUES is a 'toggle' between two groups of clues.
OTHER CLUES is always empty at the start of a game.
HINT helps you learn to play the game, but costs 30 seconds.
Wrong deduction notification costs 60 seconds of game time.
Click on the status bar at bottom to bring up Player Setup.
You can turn off these PopUp Tips in Player Setup.
These PopUp Tips don't pop up when you're pointing at an empty clue spot.
You can save a partially played game using File/Save.
You can edit the images in File/Image Editor.
Load different images using IMAGES button in Player Setup.
Clues can be re-arranged by dragging them to a new position.
Make sure you don't send useful clues to the OTHER CLUES bin.
Pull down the view menu to see your game time statistics.
Reduce your handicap (in Player Setup) as you get better at the game.
Sound effects and music can be disabled in Player Setup.

One final hint: The Surgeon General has found playing Sherlock to be an addictive 
habit, and should be avoided during times of work hours, cooking hours, and other 
dutiful moments.    Remember to talk to your family members, and don't forget to sleep.



I Give Up, Who Wants To Own A Zebra, Anyway?
You didn't really think I was going to give away the answer, now did you???

Of course not!    I wouldn't dream of taking the fun away from you.    I do guarantee, 
however, that it is solvable.

Oh, ok.    I'll give you a clue:    it's not the Ukrainian who drinks the water, and it's not the
Spaniard who own's the Zebra.

Ha, ha, ha, ha!!! (Maniacal, cackling laughter echoes off into the distance...)

Return To Frustration...



Image Editing
The Image Editor allows you to modify the images used within Sherlock, and to create 
entirely new sets of images.    The Image Editor screen looks vaguely like this:

In the upper left corner is the palette.    These are the colors from which you can select 
for drawing the images.    You select a color by pointing at it and clicking the left mouse 
button.

Beneath the palette is a window displaying a sample of the currently selected color.

Beneath the sample color window are fifteen pushbuttons which control the current 
operation being performed upon the image that you're editing.    Those are described in 
more detail below.

The largest area (in the center of the display) is the actual editing area, or Zoom, for the 
current image.    Centered beneath the zoom is a full-sized image of what you're editing 
and a half-sized image of what you're editing.

On the right is a copy of the entire .BMP file, showing all of the images used by the 
game.    You cannot draw or edit these directly.    You must first select one of them (by 
pointing at it with the cursor and then clicking the left mouse button), which will 
automatically copy it into the zoom area for editing.    These images (on the right) may 
not look completely "right".    This is because they're usually "squeezed" to fit onto the 
display (the Zoom is more important when it comes to allocating screen space), and are
there primarily for reference and ease of selection.    The full-sized and half-sized 
images beneath the zoom area should be used for accurate perception of what the 
image will look like during the game.    For more details on what the individual images in 
the .BMP are used for, see BMP Files and Sherlock.    The filename of the current image
set is displayed beneath the .BMP images.

The tool pushbuttons available in the Image Editor are:



    MARK AREA    Point at one corner of the desired area in the Zoom, hold 
down the left mouse button, drag to the opposite corner of the desired area, and then 
release the left button.    This area is now marked, and may be dragged elsewhere, 
copied to the clipboard, the clipboard can be pasted into that area (getting automatically
compressed or stretched to fit the area), flipped horizontally or vertically, or a specific 
color within that area can be replaced.

 COPY    If an area of the Zoom is marked, just the marked area is copied to the 
clipboard.    Otherwise, the entire Zoom image is copied to the clipboard.

 PASTE    The clipboard is pasted into the Zoom area.    Once pasted, it's not 
actually "stuck" to the image, but can be dragged to it's final resting place (at least, until 
you click one of the other buttons or do some other silly thing).    If an area is marked 
when the paste is done, then the clipboard is stretched or compressed to fit exactly into 
that marked area.    Otherwise, the clipboard is pasted at the top-left corner of the Zoom 
with no stretching or compressing.    If you want the clipboard to be stretched or 
compressed to fit exactly into the entire Zoom image, then first mark the entire Zoom 
image.    (Elementary, my dear Watson.)

 REPLACE COLOR  When you click the left mouse button upon a pixel of the 
Zoom area, all instances of pixels with that color will be changed to have the "current" 
color (shown beneath the Palette).    So, let's say that you want to change the blue 
house to be a gray house.    Select the Replace Color button, select the shade of gray 
that you wish from the Palette, then point at one of the blue pixels on the house (in the 
Zoom area) and click the left mouse button.    Magic presto.

 VERTICAL FLIP    This button is an "instant action" button, as opposed to a 
"mode" button.    As soon as you click on this button, the marked area of the Zoom (or 
the entire Zoom image if no area is marked) will be flipped top-to-bottom.

 HORIZONTAL FLIP    This button is an "instant action" button.    As soon as you 
click on this button, the marked area of the Zoom (or the entire Zoom image if no area is
marked) will be flipped left-to-right.

 SPRAY CAN    This button makes your drawing tool be a "spray" of pixels.    The 



size of the spray is controlled by the TOOL SIZE control.    The color is specified by the 
Palette.    Click the left mouse button on the Zoom to spray the current color at that 
location.    Hold the left mouse button down and drag the mouse to spray continuously.

 TOOL SIZE    This button controls the size of your drawing tool (spray can, pencil,
outline rectangle and oval, and line).    Click in one of the four corners of the Tool Size 
button to select tool widths of 1, 2, 3, or 4 pixels.    (Be sure to keep the mouse pointing 
at the desired corner of the button until you RELEASE the left mouse button, as that's 
when the selection is determined.)

 PENCIL    This selects the pencil as your drawing tool.    Pretty standard stuff.    
Click the left mouse button on the Zoom to plot a single pixel of the current color, or hold
the left mouse button down and drag the mouse to drag ...er... draw onto the Zoom 
area.    If you're trying to draw a straight line, try using the Line tool instead of the 
Pencil.

 OUTLINE RECTANGLE    This draws the outline of a rectangle using the current 
color.    Point at one corner, hold down the left mouse button, drag to the opposite 
corner, and release the mouse button.

 SOLID RECTANGLE    This draws a solid rectangle using the current color.

 OUTLINE OVAL    This draws the outline of an oval.    Exciting stuff, huh?

 SOLID OVAL    This draws a solid oval.    Have you really never used a computer 
drawing program before?

 LINE    Let's see... What does this do, again???

 COLOR SAMPLE    With this selected, point at a pixel on the Zoom and click the 
left mouse button.    The "current color" selected in the Palette will be changed to match 
the color of the pixel which you selected.    This is a pretty worthless button, because at 
ANY time, you can point at a pixel on the Zoom and click the RIGHT mouse button to do
the same thing.    Pretty handy, huh?    You see, it does pay to read all of these inane 
help screens, so that you can find out these kinds of handy facts.



THE FILE MENU
If you Open (using the File menu) an image set, that image set becomes the default set 
for the current player.    This is the equivalent of entering the Player Setup Dialog, 
clicking on the Images pushbutton, and selecting the image set there.

Also in the File menu is Import .SHI File.    This will convert a Sherlock for DOS .SHI 
image set into a .BMP file (and load it into the image editor) for you.

You can return to playing the game by selecting Play Game from the File menu.    What 
a concept.

THE EDIT MENU
The first item of utmost interest is the Undo entry.    This will save your button many 
times if you do much image editing.    Don't depend upon it (because it will probably fail 
you just when you need it the most), but it will usually be able to lend a helping hand.

The other item in the Edit menu that requires comment is the Resize entry.    This allows
you to take an image set that is designed for one screen resolution, and convert it to a 
different screen resolution.    Now, the result will be a bit crude, since the computer has 
to stretch or compress the image, and quite a bit of touch-up will be required.    But, it's 
frequently better than starting over from scratch.    The widths and heights that are 
mentioned in the dialog box are the width and height in pixels of each individual image.   
The screen resolutions in parentheses is the screen size that the image size would best 
work with when the game is maximized on the display.    When you click on OK, a "file 
save as..." type of file dialog box will appear, letting you specify the filename to which 
you wish the resized images to be written.    The original .BMP file will not be modified.

OTHER POINTS OF INTEREST
Let's see.    You can't bring up the Player Setup Dialog while in the Image Editor, so 
clicking on the status bar won't do you any good.

Remember to read the BMP Files and Sherlock section if you're really serious about 
editing images.

If you wish to import graphic images from elsewhere into a Sherlock BMP image set, 
one way to do it is to use another program to load that graphic image and copy the 
appropriate portion to the Windows clipboard.    Then, in the Sherlock for Windows 
Image Editor, do a paste.    Voila.

Time stops for no one, so if you Play Game after spending some time in the Image 
Editor, remember to Restart Game also, or you may find that a game took MUCH longer
than it seemed.



Image selection    The entire .BMP file, showing all of the images used by the game.    
Individual images must be selected into the Zoom before they can be edited.    These 
images are usually not "game-sized", but compressed to best fit within the display area.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Sherlock and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Music and Sound
This is another one of those "techie" discussions, so feel free to skip it if you just enjoy 
playing the game.

The music files are called SHERLOCK.MID and SHERWIN.MID.    These are MIDI files, 
and if you have MIDI files of music that you would prefer to these, merely copy your 
MIDI files over SHERLOCK.MID (the "theme" music) and/or SHERWIN.MID (the "win" 
music).

Starting with version 3.2 of Sherlock, the Player Setup Dialog contains an extra 
checkbox, giving you separate control over whether the background "theme" music 
plays and whether the "win" music plays.    SHERLOCK.MID is the "theme" music file, 
and SHERWIN.MID is the "win" music file.    (I'll bet you wouldn't have figured that out 
on your own, would you have?)

The sound effects are standard .WAV ("wave") files, and you can also replace these 
(should you want to) with .WAV files of your choice.    The files (and their purposes) are:

REMOVE.WAV when you move a clue to the OTHER CLUES area.
DROPOSS.WAVwhen you drag (with the right button) an image to a column of the 

playing board.
ILLCLICK.WAV when you click somewhere that makes absolutely no sense.
NOTPOSS.WAV when you remove an image as a possibility from the playing 

board.
MOVECLUE.WAV when you drag a (horizontal or vertical) clue to a new 

location.
KNOWN.WAV when you enlarge an image on the playing board because 

you know (or think you know) where it's located.
EXP1.WAV used during the Fireworks "win" display
EXP2.WAV ditto
EXP3.WAV ditto some more
EXP4.WAV what do you think?
MISTAKE.WAV when you make an incorrect deduction on the playing board 

(and have "notify on wrong deduction" turned on).
WEAVE1.WAV used during the Weave "win" display
WEAVE2.WAV ditto
WEAVE3.WAV ditto some more
WEAVE4.WAV didn't we just go through all of this with the Fireworks WAV 

files?
WEAVE5.WAV you're on your own on this one.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Palette    These are the colors from which you can select for drawing the images.    You 
select a color by pointing at it and clicking the left mouse button.



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+V



Player Setup Dialog
The Player Setup Dialog is where each player customizes the game to best suit his, her,
or its tastes.    The various fields are:

Current Player: Shows the name of the current player.    This name must be no more 
than 31 characters.    Entering a new name in this field adds a new player to the game.   
To change a players name, use the Rename pushbutton.

Rename: This pushbutton brings up the Rename Player dialog which allows you to 
change the name associated with a particular player.    All time statistics and other 
player configuration information is retained, only the name is changed to protect the 
guilty.

Delete: This pushbutton is used to delete the current player (well, the data for the 
current player, anyway), removing the player name from the player list, and removing all
time statistics from the database.

Puzzle #: This is the current puzzle number being worked on by the current player.    
Puzzles numbered 0 through 65535 almost always have at least one "given" location on
the playing board.    Puzzles 65536 through 131071 never have any "given" locations on
the playing board (except for those given away by a non-zero Handicap setting).

Handicap: Speaking of Handicap, the Handicap setting controls how many additional 
locations on the playing board are "given away" at the beginning of the puzzle.    True 
aspirants to the name "Sherlock" will, of course, always set this to 0.    However, it's 
understandable that some of us must fill the role of Watson, so it's okay to set this to 
non-zero values while you're first learning the game.

Sound effects: If checked, sound effects will be heard through your sound system when 
various actions are taken (moving clues, removing possibilities, removing clues, 
enlarging possibilities, making mistakes, etc).    If you subscribe to the belief that 
"Silence is Golden", remove the check from this item.

Theme Music: This controls whether "theme" (background) music music plays or not.    
When checked, a background tune will play while you play the game.

"Win" Music: This controls whether "win" music will be played when you successfully 
complete a puzzle.    (Note:    I said "when", not "if".)

Random puzzle sequence: This check box (when checked) will cause a random puzzle 
number to be chosen each time a new puzzle is started.    Otherwise, the puzzles will be
encountered sequentially.

Notify on wrong deductions: When checked, you will be notified when you make an 
incorrect deduction on the playing board.    It is strongly recommended that you keep 
this item checked until you become very proficient at the game.    However, you should 



realize that each time you are notified that you've made an incorrect deduction, 60 
seconds are added to your elapsed time for the current puzzle.

Pop-up tips: When checked, small "hint" windows will popup anytime the cursor pauses 
over a clue for more than about a second.    These pop-up tips are intended to help you 
learn how to play the game (especially what the various clues mean), and you will 
probably want to turn this feature off as soon as you've learned the clue types.

Images: This pushbutton opens a file dialog so that you can specify a different .BMP file 
from which to load images for the game.    Whatever file is specified in this dialog 
becomes the default imageset for the current player, and it will automatically be 
reloaded the next time you run the game.

"Win" display effects:    When you solve a puzzle, you will see a fun little display and 
(assuming you have Music enabled and have a sound card in your computer) hear a 
congratulatory piece of music.    The type of "display" that you see is controlled by this 
set of radio-buttons.

Random Win display: randomly chooses one of the "win" displays.
Fireworks: looks like.......fireworks.
Quilt:    makes a .....quilt-like...... pattern.
Weave: makes your computer weave back and forth like an unsteady toddler.

Captions on clue windows: Controls whether the Playing Board, Vertical Clues, and 
Horizontal Clues windows have captions or not.    If you want to maximize the size of the
small images on the Playing Board, uncheck this item to free up a little valuable screen 
"real estate", then move the clue windows around to give the Playing Board as much 
room as possible.    Stretch the Playering Board to make it as big as possible, and the 
small images will be scaled to fit.    The images will look the best, though, if you keep the
Playing Board roughly square.

Show GAME pushbuttons: Shows (or hides) the window containing the "game" 
pushbuttons.    The functionality of these buttons is also available through the "Game" 
pulldown menu, so the pushbuttons are merely a convenience.    If you're trying to 
maximize the size of the small images on the Playing Board, try turning off the Game 
pushbuttons and then rearranging the windows.

Prompt before starting new Game:    For some unfathomable reason, some folks want to
stop playing Sherlock, and they find this too difficult to do if the next game just starts up 
automatically.    So, this option is included to help those poor suffering souls break the 
habit.



Popup Tips
These annoying little popup help windows are designed to help you learn to play the 
game more quickly.    Any time the cursor stops over a clue for a second, the popup 
window appears to explain the meaning of that clue, along with another brief tip (tip: 
american slang referring to a wide range of subjects, from taxis and restaurants to the 
subject at hand: a helpful hint honed to heinous heights of hearty helping hands)...as I 
was saying, along with another brief tip regarding the use of the program.

When these popup hints become more annoying than helpful, they can be turned off 
quite easily with a checkbox in the Player Setup Dialog.

For a list of the various "helpful hints", see Hints and Tips.



Printing
Sherlock puzzles can be printed on your printer, but probably aren't "worth your while" 
unless you have a color printer.    A black and white LaserJet type printer can print them 
reasonably well, but they can be very difficult to play (in monochrome) unless you have 
an image set that is particularly well adapted to this.    Also, the time that it takes to print 
a puzzle is VERY dependant upon the printer driver.    It takes around 5 or 6 minutes for 
my LaserJet to print one puzzle (because it's having to convert all of the 256 color 
images to monochrome dithered images), whereas my color inkjet printer prints a 
puzzle in less than a minute.    Strange but true.

The Best Times and Puzzle Times lists can be printed quite well on most printers, 
although older impact printers (non-graphic capable) might experience some difficulties. 
Again, the printer driver will have some impact upon this.

What else is there to say?    Sherlock is meant to be played on the screen, not on paper. 
What are you doing killing trees?



Puzzle Times Dialog
The Puzzle Times dialog is closely related to the Best Times Dialog.    They both display 
lists of solved puzzles.    However, while the lists in the Best Times dialog are sorted by 
"best time" (what else?), the list in the Puzzle Times dialog is sorted according to puzzle
number.    This allows you to easily discover how fast you (or a competitor) solved a 
particular puzzle.    This list contains the times for all of the puzzles solved by all of the 
players.

The Puzzle Times dialog makes it reasonably easy to run a "tournament", where 
everyone (who's anyone) tries to solve the same puzzle number the fastest.    Of course,
you'll have to keep one eye on the screen and one eye on your competitors to make 
sure they're not looking over your shoulder!



Resize
The Resize dialog allows you to take an image set that is designed for one screen 
resolution, and convert it to a different screen resolution.    Now, the result will be a bit 
crude, since the computer has to stretch or compress the image, and quite a bit of 
touch-up will be required.    But, it's frequently better than starting over from scratch.    
The widths and heights that are mentioned in the dialog box are the width and height in 
pixels of each individual image.    The screen resolutions in parentheses is the screen 
size that the image size would best work with when the game is maximized on the 
display.    When you click on OK, a "file save as..." type of file dialog box will appear, 
letting you specify the filename to which you wish the resized images to be written.    
The original .BMP file will not be modified.



The Horizontal Clues

The Horizontal Clues area is to the right of the playing board.    These clues show 
relationships between items that are in different columns.



The Playing Board

The Playing Board consists of six rows, with each row containing six related pictures 
(six people, six numbers, six different fruits, etc).    Initially, each location in a row shows 
all six possibilities for that row as half-sized images.    The half-size image indicates that 
they are only possibilities.    When a row/column location is inhabited by a single full-
sized image, that indicates that the block is (or, at least, is believed to be) located there.
As you deduce that an item can't be in a given square, the right mouse button can be 
used to remove that possibility from that location.    When you've deduced that a specific
item has to be at a specific location, the left mouse button can be used to signify it.



The Vertical Clues

The Vertical Clues area is across the bottom of the Sherlock window (beneath both the 
playing board and the horizontal clues).    The vertical clues show relationships between 
items that are in the same columns.



Tool Buttons    Fifteen pushbuttons which control the current operation being performed
upon the image that you're editing.



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.    The Undo command 
grayed out on the menu if you cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Using Help command (Help menu)

Use this command for instructions about using Help.



View menu commands

The View menu offers the following commands:

Best Times View All and Personal puzzle times sorted by increasing 
time.

Puzzle Times View All puzzle times sorted by puzzle number.



Who Drinks Water and Who Owns the Zebra
So, you'd rather do one of these the hard way, huh?    Actually, this one is harder than 
the Sherlock puzzles (as are most of the ones in the magazines), because eventually 
you get to the point where you have to say, "Ok, what if this item were here....then, 
would there be any contradictions, or would that work?"    With Sherlock, you never have
to make a what if supposition...just keep making logical deductions from the presented 
information.    One of these days, I may make an advanced version of Sherlock which 
requires these suppositions, for the really hard-core fans.    Anyway, on with the puzzle:

1. There are five houses, each a different color and inhabited by men (this is a sexist 
puzzle) of different nationalities, with different pets, drinks, and cars.

2. The Englishman lives in the red house.
3. The Spaniard owns the dog.
4. Cocoa is drunk in the green house.
5. The Ukrainian drinks eggnog.
6. The green house is immediately to the right (your right) of the ivory house.
7. The Oldsmobile owner owns snails.
8. The owner of the Ford lives in the yellow house.
9. Milk is drunk in the middle house.
10. The Norwegian lives in the first house on the left.
11. The man who owns the Chevrolet lives in the house next to the house where the 

man owns the fox.
12. The Ford owner's house is next to the house where the horse is kept.
13. The Mercedes owner drinks orange juice.
14. The Japanese man drives a Volkswagen.
15. The Norwegian lives next to the blue house.

Who drinks water?    Who owns the zebra?

If you get stuck, click here: I Give Up, Who Wants To Own A Zebra, Anyway?



Window Management
Starting with version 3.2 of Sherlock for Windows, the Playing Board, the Vertical Clues,
the Horizontal Clues, and the game pushbuttons have been moved into their own little 
windows.    The reason for this was that, depending upon the resolution of the display, 
the images could be a wee bit small, and the original arrangement of the images wasn't 
necessarily optimimum for all display resolutions.    Now, with everything in its own 
window, you can move things around to best fit your desires (well, at least your desires 
that have to do with playing Sherlock).

The Horizontal and Vertical Clues windows and the Playing Board window have optional
"caption" bars.    These can be turned on or off in the Player Setup Dialog.    With 
captions turned off, you have a little more room on the display for organizing the 
windows to maximize the size of the images on the Playing Board.    Also, the "game 
pushbuttons" (Other Clues, Undo, Hint, Pause, Restart, and New Puzzle) can be turned 
off (hidden) via a checkbox in the Player Setup Dialog.    Even with the pushbuttons 
turned off, their functionality is still available via the "Game" pull-down menu.

The Horizontal and Vertical Clues windows will always display the clue images at "full 
size", but as you reduce or increase the width of these two windows, the placement of 
clues within the windows will be automatically adjusted, using however many columns 
of clues will fit within the given window width, and using how ever many rows are 
necessary to hold all of the clues.    There are no scroll bars, however, (who wants to be 
scrolling up and down all the time to see the clues?) so you need to be careful when re-
arranging the windows to provide enough room for ALL of the clues to be visible.

Most importantly, the Playing Board can be sized, and the SMALL images on the 
playing board will be stretched to fit the available room.    (The size of the small images 
has to be kept to an even number of pixels, however, so the playing board won't always 
perfectly fill the window.)

The "game pushbuttons" window never has a caption, so the only way to move it is to 
grab the corners of the frame and stretch first one corner, then the other, to where you 
want it to be.    It will temporarily cover the other windows as you move it, but c'est la vie.

And if you get the windows all goofed up, never fear: there's a command in the "Game" 
pull-down menu called "Default window positions" that will automagically move all of the
windows back to their default sizes and positions for your display's resolution.



Zoom    The actual editing area, live and up-close, for the current image.






